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The list of terms used
The Guide – this document: Auto-Intellect Software Package: Operator's Guide.
The system – the  software system.Auto-Intellect
Server - computer with installed  software package.Auto-Intellect
Traffic – the flow of vehicles.
Vehicle Tracer – the interface object designed for viewing the recognized LP numbers, the types and speeds of vehicles, as well as for searching the LPR database and creating
reports for specific time periods.
Traffic Monitor – the interface object designed for monitoring vehicle movement.
fps - frame frequency. Number of video stream frames processed by software per 1 second.

Introductiоn
On page:

The purpose and structure of the Guide
The purpose of the Auto-Intellect system
Recommendations for using the Auto-Intellect system

The purpose and structure of the Guide

The Guide is an informational reference designed for users of the  system with Operator access rights responded for operation with  software andAuto-Intellect Auto-Intellect
corresponding interface objects.

The Guide contains the following material:

General description of the  software system.Auto-Intellect
How to use the  software system.Auto-Intellect
Description of the user interface of the  system.Auto-Intellect

The purpose of the Auto-Intellect system

The  software system is designed for automated traffic monitoring and control, and has the following functionality:Auto-Intellect

License plate number recognition.
Centralized events registration and processing, generation of notifications and control commands according to flexible algorithms.
Searching matches between the recognized plate number and the numbers in the database connected to Auto-Intellect.
Creating the photo and video archive.
Determining the overall traffic parameters and the parameters of individual vehicles.
Software scalability.

Recommendations for using the Auto-Intellect system

The  software is installed as an extension to the Intellect software package.Auto-Intellect

For proper operation of the  system, please follow these recommendations:Auto-Intellect

https://doc.axxonsoft.com/confluence/display/auto50en/Operator%27s+Guide
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Follow the job description accurately.
Use the system for the intended purpose only.
Do not use the computer with  installed, to run other software which is not part of the  package.Intellect Intellect

General description of the Auto-Intellect software package
The structure оf the Auto-Intellect system
Auto-Intellect includes the basic  of the  software package with additional software modules, including those from third-party vendors that carry out particular functions:version Intellect
recognizing the vehicle parameters and registering the related events.  includes the following software modules:Auto-Intellect

Auto-Uragan 3.5.0.29;
Arena;
CARMEN-Auto;
Carmen-parking;
VIT;
Radar;
Traffic Detector;
Traffic Light Detection;
External Plates Database;
Vehicle detector (included in information-gathering subsystem about traffic);
Vehicle processor (included in information-gathering subsystem about traffic);
Vehicle tracer.

The Autо-Uragan 3.5.0.29 module functionality
The  software module supports the following functionality:Auto-Uragan 3.5.0.29

License plates identification;
Saving the identified number to the plates detector database;
Identification and logging the determined speed of the vehicle to the plates database (while connecting the Radar module);
Identification and logging the determined class of a moving vehicle to the plates database (while connecting the Traffic detector module);
Check of identified license plates via connected search database;
Possibility to work with multilane driveway;
Identification of extended list of license plates types: all types of Russian license plates, all CIS countries and Baltic States, countries of Europe, Latin America and The USA.
Worked out the main types of single-line plates of different countries, for each both civil and specialized (diplomatic, transit, military etc.);
Plates filtration according to their characters' sizes
Possibility to change level of plates' identification quality
Saving the frames of the identified plates to bmp, jpeg and avi formats
Calculation of the capture lanes in the area of identification restriction
Setting the alarm when the vehicle entering an oncoming lane.

The  software module restricts operation with different typical plates'sizes and templet recognition with the abscense of new licensing key. Auto-Uragan 3.5.0.29
The  software module uses the IPP 6.1 library. Auto-Uragan 3.5.0.29
The  software module can work in one of the following modes:Auto-Uragan 3.5.0.29

Note.
The database of identifiers/detections and the object from which the data is received to this database are to be located in one computer for correct working of  soAuto-Intellect
ftware package.
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Slow — the module processes the video stream with the speed not exceeding 3 fps.
Fast – the module processes all incoming frames.

The Arena mоdule functionality
The  software module supports the following functionality:Arena

License plates identification;
Saving the identified number to the plates detector database;
Identification and logging the determined speed of the vehicle to the plates database;
Identification and logging the determined class of a moving vehicle to the plates database.

The CARMEN-Autо module functionality
The  software module supports the following functionality:CARMEN-Auto

License plates identification;
Saving the identified number to the plates detector database;
Identification and logging the determined speed of the vehicle to the plates database (while connecting the Radar module).

Supported number of recognizing streams is summed if several usb keys are in use. For example, if one key for one channel is installed, the fps processing is 10 fps. While the same
second key installing the fps processing will be 20 fps. In this case it is possible to create two recognizing channels and on every channel the fps processing will be equal to 10 fps.

The Carmen-parking mоdule functionality
The  software module supports the following functionality:CARMEN-parking

License plates identification;
Saving the identified number to the plates detector database.

The ACCR mоdule functionality
The  software module supports the following functionality:ACCR

Identification of transport containers' license plates;
Saving the identified number to the plates detector database.

The VIT mоdule functionality
The  software module supports the following functionality:VIT

Recognizing the license plates.
Saving the recognized number to the plates detector database.
Determining and logging the speed of the recognized vehicle to the plates database (if the Radar module is connected).
Check the recognized plates of vehicles via connected search database.
Possibility to work with multilane driveway (recognizing of vehicle plates in one frame is not more than 10).
Identification of extended list of license plates types: all types of Russian license plates, all CIS countries and Baltic States, countries of Europe, Latin America and The USA.

Note.
Sum of processed number of recognizing streams is allowed for multi-cores systems (which have several streams). Computers based on the Core i3, Core i5, Core i7
processors belong to these systems. Exact number of cores (streams) see in the documentation to the corresponding processor.
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Worked out the main types of single-line plates of different countries, for each both civil and specialized (diplomatic, transit, military etc.).
Possibility to change the quality level of vehicle plates recognizing.
Saving the frames of the recognized plates to bmp, jpeg and avi formats.
Calculation of the capture lanes in the area of recognizing restriction.

The  software module restricts working with different types of vehicle license plates in accordance to the Hasp licensing key.VIT
The  software module can work in one of the following modes:VIT

Slow — the module processes the video stream with the 6 fps speed.
Fast – the module processes the video stream with the 25 fps speed.

The working mode of the module also depends on  licensing key.Hasp

The Radar mоdule functionality
The  software module supports the following functionality:Radar

Registering the hardware devices of the speed-trap type.
Determining the speed of the vehicle using the speed-trap device.

The Traffic Detectоr module functionality
The  software module is designed for determining general characteristics of the traffic, as well as of each vehicle's parameters.Traffic Detector

It supports the following functionality:

Determining the overall number of vehicles that passed in each lane.
Saving the date and time of vehicle registration.
Determining the class of the vehicle.
Calculating the total number of vehicles of each class.
Determining the speed of the vehicle (using the video image processing algorithm).
Determining the speed of the vehicles moving along a specified lane.
Calculating the average traffic speed.
Calculating the average speed of the vehicles by their class:
a. motorcycle;
b. passenger car;
c. truck shorter than 12 m;
d. truck longer than 12 m;
e. bus.
Determining the distance between the vehicles (up to 255 m).
Calculating the road load.
Registering some moving violations:
a. exceeding the speed limit;
b. driving along the wrong side of the road;
c. stopping violations;
d. invalid reversing;
e. driving forbidden types of vehicle.
Detecting traffic jams.

The following tools can be used to create the report by results of detector working:

Intellect Web Report System module. This module is not included in the distributive of  software and is installed separately (see Auto-Intellect Intellect Web Report System.
 document).User guide

https://doc.axxonsoft.com/confluence/display/rpt212/Intellect+Web+Report+System.++User+Guide
https://doc.axxonsoft.com/confluence/display/rpt212/Intellect+Web+Report+System.++User+Guide
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Traffic monitor object. Configuration of this object is described in the Traffic Monitor interface object setup section. Working with the dialog box is described in the Auto
 document).Intellect Software Package. Operator's Guide

The Traffic Light Detectiоn module functionality
The  software module is designed for the following functions:Traffic Light Detection

Determining the traffic light state without connection to the traffic light controller.
Creating the messages about permitted and forbidden moving directions.
Transmitting the data about permitted and forbidden moving directions to the  module.Traffic violations detection

The External Plates Database mоdule functionality
The  software module is designed for comparing the recognized plate number with the number from the external database.External Plates Database

The Information-gathering subsystem functiоnality
On the page:

The Vehicle detector functionality
The Vehicle processor functionality

 

The information-gathering subsystem module is designed for:

Determining the overall parameters of vehicles that passed in camera's view;
Gathering information about traffic in general on the basis of vehicles' parameters statistic analysis;
Saving the information about traffic to database.

To realize the information-gathering subsystem features the following program modules should interoperate:

Vehicle detector;
Vehicle processor.

Use the  module to create reports based on the results the operation of data acquisition subsystem (see ).Intellect Web Report System Intellect Web Report System . User Guide

The Vehicle detector functionality

Vehicle detector module is the information-gathering subsystem about traffic in the  software complex.Auto-Intellect

The module is designed for:

Registering vehicle's entrance and exit from the detection zone;
Determining the speed of the vehicle;
Determining the class of the vehicle;
Transmitting the data about the vehicle to the  module for handling and saving to the database.Vehicle processor

The Vehicle processor functionality

The  module is a part of the information-gathering subsystem about traffic in the  software complex.Vehicle processor Auto-Intellect

The module is designed for:

https://doc.axxonsoft.com/confluence/display/auto50en/Operator%27s+Guide
https://doc.axxonsoft.com/confluence/display/auto50en/Operator%27s+Guide
https://doc.axxonsoft.com/confluence/display/rpt212/Intellect+Web+Report+System.++User+Guide
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1.  
2.  

1.  
2.  
3.  
4.  

1.  
2.  
3.  
4.  
5.  
6.  

Statistic data analysis of vehicles, received from the Vehicle detector module to gather overall information about vehicles;
Saving the data about traffic to the database.

The Traffic viоlations detection functionality
The  module is designd for identifying vehicles that have passed on the red light. Identifying is performed in real time.Traffic violations detection

The  module supports the following functionality:Traffic violations detection

Setting the alarm when the red light passing is detected.
Setting the alarm when the vehicle going through the stop line on the red line.
Setting the alarm when the vehicle stops over the crosswalk line on the stoplight.
Registering the events in the database.

The Vehicle tracer functiоnality
Vehicle tracer module is designed for identifying vehicles that are on the wanted list or overspeeding. Identifying is performed in real time.

The  module supports the following functionality:Vehicle tracer

displaying the plates that are in identifying detectors' view;
displaying vehicles' speed (the  module is to be connected while using the  and  modules);Radar CARMEN-Auto Auto-Uragan 3.5.0.29
registering vehicle 's overspeeding with controlled voice notification of the operator;
registering the plate identification in the external database (for example in the search base) with controlled voice notification of the operator;
alarm handling;
search events in the  recognizers database.Auto-Intellect

 

The Remоte recognition module functionality
The  module is designed for license plates recognizing using cameras with LP recognition function: Vega Access and Vega III by Tattile vendor.Remote recognition

Using the Auto-Intellect software system
Starting and closing the system
Please check the working condition of all hardware components – connections, cameras, etc – prior to starting the system.



10

1.  
2.  

1.  

2.  
3.  

The system can be started using one of the following methods:

Automatically. The system starts automatically after the operating system boots up.
Manually. To start the system manually, in the  menu, select ->  -> , or use the corresponding shortcut on the Desktop.Start Programs Intellect Client Workstation

Access to the system can be protected by a password. In this case, enter your password to start the system.

To shut down the system, do the following:

Point the mouse to the upper right corner of the screen, the main control panel will open.

Click the  icon on the panel.
Select  in the menu that opens.Shutdown

The shut down process will start, the password will be required if set.
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Using the Traffic Monitor interface object

Displaying the current traffic information in table form
The table with current traffic parameters is shown in the  sub-tab of the  tab.Table Current value

Displaying the current traffic parameters by lane in a table.

Note.
The system can be set up to forbid the shut down. Then, the  item is not present in the menu.Shutdown
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Displaying the current traffic parameters by direction in a table.
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The system can be set up to display the traffic parameters by lane or by traffic movement direction. In case of the by-lane display, the columns correspond to traffic lanes, and rows
correspond to traffic parameters. In case of the by-direction display, the columns correspond to traffic directions, and rows correspond to traffic parameters.

Displaying the current traffic information in graphic form
The charts with current traffic parameters are displayed in the  sub-tab of the  tab.Charts Current value

Displaying the charts of current traffic parameters by lane.

Note.
The  parameter for each lane corresponds to the time when the last vehicle passed. The  minus the  isTime of registration Time of registration Statistics update period
taken as the beginning of the period to base the statistics on, while the current moment is taken for the end of the statistics period.
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Displaying the charts of current traffic parameters by direction.
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The system can be set up to display the traffic parameters by lane or by traffic movement direction.

The  tab consists of several sections corresponding to the lanes or the traffic movement directions. Each section consists of several subsections displaying some particular sets ofCharts
traffic parameters in graphic form.

Creating a request for traffic statistics
To create a request for traffic statistics, use the  tab.Statistics
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1.  
2.  
3.  
4.  

To create a request for traffic statistics, do the following:

Select the preferred type of statistics presentation by clicking the  or the  tab.Table Charts
Select the sampling period – , , , or  (specify the period manually).Day Week Month Specific time period
If  is chosen, enter the beginning and the end date/time of the statistics period in the  and the  fields.Specific time period Beginning End
Click the  button to create or update the statistics.Refresh

Displaying traffic statistics in table form
The traffic statistics in table form are displayed in the  sub-tab of the  tab.Table Statistics
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The traffic statistics are displayed in the following tree structure:  ->  ->  -> . The statistics data for each level of the tree isRecognizer name Movement direction Lane Vehicle type
shown.

Displaying traffic statistics in graphic form
The traffic statistics in graphic form are displayed in the  sub-tab of the  tab.Charts Statistics

Note.
To refresh the displayed statistics, click the  button.Refresh



18



19

1.  
2.  
3.  
4.  

Saving traffic statistics to a file
The  tab allows saving the traffic statistics into a file.Statistics

To export the traffic statistics into a file, do the following:

Create and display the request for traffic statistics (see the  section).Creating a request for traffic statistics
Click the  button.Save as
Enter the pathname in the window that opens and click .Save
The traffic statistics will be saved in the specified location in a CSV file.

The Vehicle Tracer interface object

Intrоductiоn
The  interface object includes the following components:Vehicle Tracer

Note.
To refresh the displayed statistics, click the  button.Refresh
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1.  
2.  
3.  

On-line monitor – is designed for displaying the data about identified plates and for handling alarms;
Events monitor –displays video frame with a vehicle, which plate is being recognized at the moment and also identified number and speed.
Alarm window - is designed for displaying the data about vehicles in case of coincidence of recognized plates with plates which are stored on the external orientation database.

Viewing the data about passing vehicle
Viewing the data about passing vehicle is performed in the window .Events monitor

Note.
 and  components are optional and aren't displayed with corresponding system settings (see the document Events monitor Alarm window Auto-Intellect software package:

).Administrator guide

Note.
 monitor component may not be displayed due to corresponding system settings (see the document ).Events Auto-Intellect software package: Administrator's guide

https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=112525501
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=112525501
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=112525501
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1.  
2.  

a.  
b.  
c.  
d.  
e.  
f.  

3.  

In the  window the following data is displayed:Events monitor

LPR channel (the name of the corresponding object ) ( );LPR channel 1
vehicle's video frame with a sing, containing the following data ( ):2

date and time of receiving data about the vehicle;
vehicle's speed;
vehicle's direction;
speed, allowed on the controlled area of the road;
vehicle's detector id number;
control site.

vehicle's identified number and speed ( ).3

Viewing the data about the last identified vehicle
Viewing the data about the last identified vehicle is performed in the group  of  window.Last event On-line monitor

Note.
In case, when  or  module is used for identification, allowed speed, vehicle's speed and speed detector's number are displayed only if the  moduleUragan CARMEN-Auto Radar
is connected (see the document ).Auto-Intellect software package: Administrator's guide

Note.
In case when alarm is registered for a vehicle (overspeeding, and /or identification of a plate in the external plates database), a field with a video frame is underlined red ( ).2

https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=112525501
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1.  

Viewing the data about the last identified vehicle is performed in the following way:

In field 1 there is displayed a vehicle's video frame with a sign ( ).1

Note.
If there is selected an event in the identified vehicles protocol or in the alarms protocol, the data about this event will be displayed in the group  (see sections Last event Viewi

, ).ng the protocol of the identified vehicles Viewing the alarms protocol



23

1.  

2.  Identified vehicle's plate is displayed in Field 2 ( ).2

Note.
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2.  

3.  
4.  

5.  
6.  
7.  
8.  
9.  

10.  

11.  
12.  
13.  

In the  field the name of plate's detector is displayed (the name of the corresponding object ) ( ).Detector LPR channel 3
In the  string there is displayed a country in accordance with the identified number ( ).Country 4

Camera's installation address is displayed in the  string ( ).Address 5
Camera's identifier number is displayed in the ) string ( ).ID (№ 6
Certificate's number is displayed in the  string ( ).Certificate 7
The date, until which verification is valid is displayed in the  string ( ).Verification valid 8
In the  string the date and receiving time of vehicle's information is displayed  ( ).Receiving time 9
In the  string the vehicle's speed is displayed ( ).Speed 10

In the  string maximum permitted speed on this road's area is displayed  ( ).Permitted speed 11
In the  string validity of identified plate in percent is displayed  ( ).Validity 12
In the  string the vehicle's direction (  or ) is displayed  ( ).Direction Towards the camera Off the camera 13

Viewing the data about the last identified vehicle is over.

Viewing the protocol of identified vehicles
Viewing the protocol of identified vehicles is performed in  window.On-line monitor

If the plate hasn't been recognized,  message will be displayed in the field.Unidentified

Note.
The country is displayed only in case when the  or  modules are used for recognition.Uragan CARMEN-Auto

Note.
In case, if  or  modules are used for identification and  module is not connected, zero speed value is displayed.Uragan CARMEN-Auto Radar

Note.
Depending on  settings the speed is displayed in km/h or m/h (see the document ).Vehicle Tracer Auto-Intellect software package: Administrator's guide

Note.
In case if there is registered an alarm for a vehicle, the reason of alarm is also displayed in the group .Last event

Note.
In the same way one can view the data about any event, selected in the identified vehicles protocol or in the alarm protocol (see sections Viewing the protocol of identified

, ).vehicles Viewing the alarms protocol

https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=112525501
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The protocol of identified vehicles is a table which contains information about identified vehicles ( ). Select the tab , displaying the protocol of identified vehicles, to access to2 Events
the protocol ( ).1
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1.  
2.  
3.  
4.  
5.  

1.  
2.  
3.  
4.  

For every vehicle (event) the following data is displayed:

video frame of the vehicle ( );1
identified vehicle's number ( );2
vehicle's speed;
LPR channel ( );3
time of receiving information about the vehicle (4).

 For alarms there is displayed information about reasons of alarms (see section ). Unprocessed by the operator alarms are underlined red, processed-underlined yellowAlarms operation
(see section ).Alarm processing

To view the detailed information about the event it is necessary to perform the following actions:

Click with a left mouse button upon the required event.
The data about the event will be displayed in the group  in result. Operative update of the identified vehicles protocol will be suspended in the process.Last event
Viewing the data about the event according to section .Viewing the data about the last identified vehicle
To restore the active update of identified vehicles protocol click the  button in the upper area of the  window. Trace On-line monitor

Note.
In case, when  or  module is used for identification, vehicle's speed is displayed only if the  module is connected» (see the document Uragan CARMEN-Auto Radar Auto-Intelle

).ct software package: Administrator guide

Note.
Processed events may not be displayed (see section ).Hiding the processed events in the protocol

https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=112525501
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=112525501
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1.  
2.  

1.  

Viewing the detailed data about the event is over.

Alarms operation
Alarms operation is done in the  window.On-line monitor

Alarm is triggered by one of the following ways:

automatically – in case of overspeeding or vehicle's plate identification in the external database;
manually.

Manual triggering the alarm

Manual triggering the alarm is done in the following way:

Select the required event in the identified vehicles protocol, clicking it with a left button of the mouse ( ).1
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1.  

2.  
3.  

Click the  button ( ).Alarm 2
In result of this operation the event will be underlined red and added to the alarms protocol ( ).For an alarm, triggered by operator, there is displayed the reason of alarm 1 Mark

 and the time of triggering the event (2).ed by operator
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3.  

Manual triggering the alarm is completed.

Viewing the alarms protocol

Alarms protocol is a table which contains information about vehicles for which alarm has been triggered ( ). It necessary to activate a tab, that is located in the upper area of the 2 On-li
 window to access to access to the protocol ( ).ne monitor 1

Note.
Information about alarms protocol is given in the section .Viewing the alarms protocol

Note.
Data about the last alarm is displayed on the tab.
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1.  
2.  
3.  

Unprocessed by operator alarms are underlined red, processed-underlined yellow (see  section).Alarm processing

Viewing the alarm protocol is done in a similar way with identified vehicles protocol (see section ). The difference is that for an alarm there isViewing the identified vehicles protocol
displayed information about the reason of alarm:

Marked by operator - in case, when the alarm is triggered by operator (the time of triggering is also stated);
Is found in: <external database name> - in case, when the identified plate is found in the external database;
Overspeeding - in case, when the vehicle's overspeeding is registered.

Detailed information about an alarm with stating the reason of alarm one can see in the group Lat event (see  section). Viewing theViewing the data about the last identified vehicle
detailed information about an alarm is similar with viewing the data about the event, registered in the identified vehicles protocol (see  section).Viewing the identified vehicles protocol

In case when the identified vehicle's plate is found in the , the information about the vehicle, stored at this base, will be displayed. External Plates Database

Note.
Processed events may not be displayed (see  section).Hiding the processed events in the protocol
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1.  

Alarm processing

Alarm processing is done in the following way:

Select an alarm in the identified vehicles protocol or in the alarms protocol, clicking it by a left mouse button ( ).1
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1.  

2.  
3.  

Click  ( ).Accept 2
The event will be underlined yellow in result ( ).3

Alarm processing is completed.

Hiding the processed events in the protocol

There is possibility to hide processed events in the identified vehicles protocol and alarms protocol. To realize this possibility it is necessary to click the  button.Processed Hide
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Viewing the events information about alarm event in the Alarm window

In case of proper settings the  is displayed automatically in case of coincidence the recognized plates with plates stored in the database of operating monitoring.Alarm window
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1.  
2.  

In the  the following data is displayed:Alarm window

Data about fixed event: date, plate, control border, direction, database of stolen vehicle reports ( ).1
Data about stolen vehicle report: ID, LP, storing time, status information, date and time of creation, comment, name and surname of operator who create the report ( ).2

Use buttons to scroll the reports ( ).3

To confirm the alarm status click the  button ( ). As a result the alarm will be marked as received in the  window and deleted from the Approve (information sent) 5 On-line monitor
. If the  checkbox is set the confirmed alarm disappears from all  in the distributed system.Alarm window Follow Alarm windows

To close the window of stolen vehicle report click the  button ( ). After click the button the alarm status is not changed in the  (alarm is not processed).Disapprove 6 On-line monitor

Adding the comments to the events
There is possibility to add commentary to the events. This possibility is realized in the  window.On-line monitor

Attention!
There is possibility to comment accepted events (are underlined yellow) is not provided.
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1.  

2.  
3.  

To add a commentary to the event one has to carry out the following events:

To select an event in the identified vehicles protocol or events protocol, click it with a left mouse button ( ). Operative update of the protocol, displayed on the screen, will be1
suspended in result.

Click  ( ).Comment 2
Comments for the plate window will open in result.
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3.  

4.  
5.  
6.  
7.  

1.  

Enter the comment in the field after the stated date ( ).1
Click  button to apply the comment to the event ( ). Add 2
Repeat steps 2-5 for all the required comments.
To resume operative update of the protocol, displayed on the screen, click  button ( ).Trace 3

Adding the comments to the event is completed.

To view the comments to the event the required value should be selected in the identified vehicles protocol or in the alarms protocol. Comments will be displayed in one field ( ).4

Printing and exporting the data about the vehicle
Printing and exporting the data about the vehicle is done in the following way:

Select an event in the identified vehicles protocol or events protocol, clicking upon it with a left mouse button ( ). Operative update of the protocol, displayed on the screen, will1
be suspended in result.
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1.  

2.  
3.  

To build a report with vehicle characteristics click the  button ( ).Print 2
Preview report program will be run in result. Vehicle characteristics report will be displayed in this program's window.
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3.  

4.  Carry out the necessary operations with a report, then quit the program for viewing the reports, having executed the point of the main menu  ->  or clicked theFile Exit viewer

button .
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4.  

Operation

 

Call for operation

Start in the main menu Start in the contextual window Button   on the toolbar

Open the report, saved in.rsd or .xml File->Open -

Save the report in .rsd or .xml File ->Save -

Export the report to one of the most common formats File ->Export -

Print the report File ->Print -

Activate the tool «Arm» View-> Scrolling Scrolling

Zoom in the displaying of report's pages View ->Zoom in Zoom in

Zoom out the displaying of report's pages View ->Zoom out Zoom out

Enable dynamic scaling of report's pages View ->Dynamic scaling Dynamic scaling

Zoom in the selected region scaling View ->Region scaling Region scaling

Scale in page size View ->In page size In page size

Scale in page's width size View ->In page's width size In page's width size

Display pages in real size View -> Real size Real size

Enter or select from the list the required scale of displaying the report's pages View ->Set the scaling Set the scaling

Enable the mode of nonstop paginal report's displaying - -

Enable the mode of by one page report's displaying - -

Go to the first report's page Navigate->The first page The first page

Go to the previous report's page Navigate ->Previous page Previous page

Go to the next report's page Navigate ->The next page The next page
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4.  

5.  

1.  

Go to the last report's page Navigate ->The last page The last page

Go to the required report's page (call for a dialog window « Go to page ») Navigate -> Go to page - -

Display the previous report's view Navigate ->Back Back

Display the next report's view Navigate ->Forward Forward

Find the required characters string in the report Document->Find Find

Update the report Document -> Update Update

Edit the report (open the editing program) Document ->Edit the report Edit the report

Display report's content - -

Display information about the program to view the report Help -> About program - -

Close the preview report program File ->Close - -

To resume operative update of displayed protocol click the  button. ( ).Track 3

Printing and exporting the data about the vehicle is completed.

Viewing the video archive by event
There is possibility to command from the component  in order to reproduce the video archive by event in the interface window the .On-line monitor Monitor

To view the video archive by event do the following:

Select the event in the identification vehicles protocol or alarms protocol, clicking upon it with a left mouse button ( ). Operative update of the protocol, displayed on the1
screen, will be suspended in result.

Note.
Operations with report files (opening, saving, exporting, and printing) are performed with standard dialog OS Windows.

Note.
To go to the required page one should enter page's number in the field  of  dialog window and then click .Page № Go to page OK

Note.
The preliminary set  object should be selected as a monitor for controlling on the  settings panel (see the document Monitor Vehicle Tracer Auto-Intellect software package:

).Administrator Guide

https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=112525501
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=112525501
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1.  

2.  
3.  

Click  ( ).Video archive 2
In case, when currently the monitor with a video surveillance corresponding to the plates identification camera is displayed on the screen, this video surveillance window will
enable the mode of displaying the archive recording by the event. Video archive navigation is described in the document . To closeIntellect software package: Operator's Guide

the video archive displaying mode it is necessary to click with a left button upon the  sign in the right bottom corner of the video surveillance window.

https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=86474942
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3.  

4.  

1.  
2.  
3.  
4.  
5.  
6.  
7.  
8.  

1.  

To resume operative update of displayed protocol click the  button ( ).Trace 3

Viewing the video archive by event is completed.

Using the filters in the protocols
There is possibility to select events to be displayed in the identified vehicles protocol and alarms protocol.

Events may be selected, using the following events:

speed;
overspeeding;
plate;
validity;
region;
direction;
alarm type;
identifiers.

Selection of filters, used in the protocols, is done in the following way:

Attention!
Both displayed and hidden in the protocol events are saved in the recognizer's database of the  software.Auto-Intellect



43

1.  

2.  

Click Filter button in the  window ( ).On-line monitor 1

Filters dialog window will be displayed in result.
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2.  

3.  From the  list ( ) select the required filter according to vehicle's speed, then enter the threshold value of the speed in the field(s) in km/h.Speed 1
The following speed filters are available:
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3.  

4.  

5.  

3.1  — the event is displayed in protocols with any vehicle's speed.No filtering
3.2  — the event is displayed in protocols in case when vehicle's speed is over threshold value.More

3.3  — the event is displayed in protocols in case when vehicle's speed doesn't exceed the threshold value.Less

3.4  — the event is displayed in protocols in case when vehicle's speed corresponds to the entered range of threshold value. Interval

From the  list ( ) select the required vehicle's overspeeding filter and then enter threshold value of overspeeding in km/h.Speeding 2
The following overspeeding filters are available:
4.1  — the event is displayed in protocols with any vehicle's overspeeding.No filtering
4.2  — the event is displayed in protocols in case when vehicle's overspeeding is over the threshold value.More

From the  list ( ) select the required vehicle's plate filter and then in the field enter the number or its part which identification leads to event's displayingLicense plate number 3
in protocols.
The following plate filters are available:
5.1  — the event is displayed in protocols with any vehicle's plate.No filtering
5.2  — vehicle's event is displayed in protocols in case, when vehicle's plate exactly matches the entered value.Register

5.3  — vehicle's event is displayed in protocols in case, when vehicle's plate contains the entered value.Contains

Note.
The threshold value is calculated as a difference between the fixed vehicle's speed and the speed, permitted in the controlled area of the road.
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5.  

6.  

7.  

8.  

9.  

From the  list ( ) select the required filter on percent of vehicle plates recognizing and then enter the threshold value of recognizing validity in the opened field (s).Validity 4
The following validity filters are available:
6.1  - events are displayed for those vehicles which plates are recognized with any validity.No filtering
6.2  - events are displayed in the protocol if the recognizing validity is higher than the specified value.More

6.3  - vehicle event is displayed in the protocol if the recognizing validity of vehicle plate belongs to the specified range of threshold values.Interval

From the  list ( ) select the required region's filter, where the vehicle has been registered, and then enter region's number in the appeared window ( ). Region 5 5
The following region's filters are available:
7.1  — the events are displayed in protocols of the vehicles, registered in any region.No filtering
7.2  — the events are displayed in protocols of the vehicles, registered in the given region.Equal

From the  list ( ) select vehicle's direction with which the event should be displayed in protocols.Direction 6
The following direction filters are available:
8.1  — the vehicle's events are displayed in protocols with any direction in respect of the plates identification camera.No filtering
8.2  — the vehicle's event is displayed in case, when the vehicle was moving from the camera.From camera

8.3  — the vehicle's events are displayed in protocols in case, when the vehicle was moving towards the camera.Towards the camera

8.4  — the vehicle's events are displayed in protocols in case, when the vehicle direction in relation to the camera has not been determined.Undefined

Note.
The expression, given for filters r and , may include usual characters and characters «*», stating for an unidentified plate's character. If theRegiste Contains
expression contains one or several characters «*», there are displayed only plates, containing unidentified characters in the set combination, in the protocols.
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9.  

10.  
11.  

From the  list select the alarm type ( ). Only alarms of the selected type will be displayed in protocols.Alarm type 7
The next alarm type filters are available:
9.1  — the vehicle's events are displayed in protocols with any alarm type or its absence.No filtering
9.2  — the vehicle's events for which overspeeding has been registered are displayed in protocols.Overspeeding

9.3  — the vehicle's events which plates have been found in the external plates database are displayed in protocols.LP found in database

9.4  — the vehicle's events, initialized manually, are displayed in protocols.Alarm set by operator

9.5  — the vehicle's events for which running a red light has been registered are displayed in protocols.Running a red light

9.6  — the vehicle's events for which entering the oncoming lane has been registered are displayed in protocols.Entered the oncoming lane

9.7  — the vehicle's events for which crossing the stop line has been registered are displayed in protocols.Crossed the stop line

9.8  – the vehicle's events for which stopping on the crosswalk line has been registered are displayed in protocols.Stop over crosswalk line

In the group  ( ) set the checkboxes for those LP recognition Servers, which data have to be displayed in protocols.Plates recognizers 8
Click  to save filters settings and close the  dialog window ( ). OK Filters 10
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1.  

2.  

Selecting the filters, used in protocols is over.

There is possibility to disable filters without changing the settings in  dialog window. Click the button  for it ( ). All the registered events will be displayed in protocols in Filters Show all 2
result. To resume the usage of filters, this button should be repeatedly pressed.

Viewing the Vehicle Tracer errors
Without Vehicle Tracer errors the  button in the right upper corner of  window is green. If errors are registered, the button is red.Server status On-line monitor

If errors are registered, the button is red.

To view the  errors, do the following:Vehicle Tracer

Click the button .

Note.
To reset all the settings it is convenient to use  button ( ).Reset 9
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2.  

3.  

4.  

5.  

6.  
7.  

Errors dialog window will be displayed in result.

Data about occurred errors are displayed in Field 1 ( ).1

A list of all possible error sources is displayed in Field 2: LPR channels and/or external databases. Current error sources are marked by  sign, idle sources are marked by  
sign ( ).2
To delete data about errors and close  dialog window click  button ( ).Errors Clear 3

To close  dialog window without deleting data about mistakes, click  button.Errors
The button  will become green in result.Server status

Viewing the Vehicle Tracer errors is completed.

Creating the additional components of On-line monitor
There is possibility to create additional interface components . Make a left double click upon the component  to create an additional component. InOn-line monitor Events monitor
result of this operation there will be displayed an additional  component in the center of the screen.On-line monitor
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Creating of additional  is completed.On-line monitor

Searching the events in the recognizer’s databases
Searching the events in the recognizer's databases of the  program complex is performed in the dialog window . To callAuto-Intellect Events search in the recognizer's databases
for this window click the  button in the interface object .Search On-line monitor
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1.  
2.  
3.  

1.  
2.  
3.  

Full functionality, provided to operator in the window , is the following:Searching the events in the recognizer's databases

Searching the events, stored at both local and remote recognizer's databases of the Auto-Intellect program complex.
Printing the reports concerning the search results.
Creating an own plates database (  database).Active tracer

Setting up the events search

On the page:
Selecting recognizer databases for events
search 
Event search results setup
Set up the video archive

 

Events search is set up in the following way:

Select the database, where events should be searched.
Set up the displaying of events search.
Set up the video archive.
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1.  

Selecting recognizer databases for events search 

To select recognizer databases for events search, select servers where required LPR databases are. To carry this out select the point  ->  Servers <Name of the required database>

of the main menu in the  window. As a result the server will be marked with  icon.Event search in the Recognizers DBs

There will be search by selected servers.

 

Event search results setup

Event search results are presented in the table. There is a possibility to choose which table's columns should be displayed and which shouldn't, to add new columns and also edit their
displayed names.

To set up the displaying of search results do the following:

Select  in the main menu of the .Settings Event search in the Recognizers DBs

As a result  dialog box is displayed. Set up of the event search results displaying is carried out in  tab. Settings Configure fields

Note.
To select all system servers select the point  -> .Servers Select all

Note.
Results of search on the server heading will be highlighted by red if some of selected servers is unavailable for search. If all servers are available for search the heading will
be highlighted by green.
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1.  

2.  In the central field of the window ( ) set the checkboxes for the columns that should be displayed in event search results table.1

Columnname (on default) Column's content

Frame Video frame with a vehicle

Vehicle's speed Vehicle's speed

Number Identified plate's number

Region number Region of identified number

Country Country of the identified number

Detector name Object name , corresponding to Vehicle's detector numberLPR channel

Date Data of vehicle's identification

Note.
For displaying all the available columns in the search results table set the checkbox  ( ). If this checkbox isn't set, search results table is notSelect\deselect 2
displayed.
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2.  

3.  

Detector address Number's detector address

Valid speed, km\h Speed in km\h , that is valid on the road's area/ controlled by number's detector

Overspeed, km\h Vehicle's overspeeding in km\h

Direction A check, that the vehicle was moving towards the camera, detecting numbers

Authenticity, % Plates identification authenticity is given in percent

Alarm time Time of alarm registration according to the identified number

Alarm detection time Time of alarm detection by the PC operator of the Auto-Intellect

Delay of alarm acceptance, sec Time between registering the alarm and its acceptance by operator

Commentary Commentary , added by the operator to the event with a vehicle

Alarm type Alarm type(overspeeding or vehicle's identification in the external plates databases)

Alarm processed A check, that the alarm has been accepted by the operator

External database A check, that the alarm has been found in the External database

Alarm initiated by Operator name who initiate the alarm

Alarm accepted by Operator name who process the alarm

Red-light phase start time Time of start alarm during which alarm was fixed

Time passed since the red-light phase start Time period passed since the red-light phase starts until the alarm fixing moment

To add a new column to the event search results table do the following:
3.1 Click  ( ). As the result dialog box opens.Add 3 Configure fields 

3.2 In the  enter the column's name in the connected recognizer's database, which content is required to be displayed in the event search results table (Field name in the DB 1
).
3.3 In the  enter the name of this column in the event search results table ( ).Field name in the interface 2
3.4 Click  to save the applied changes and close  dialog window ( ).Save Configure fields 3

Note.
Click  to close this window without saving any changes ( ).Cancel 4
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3.  

4.  

5.  

1.  

To edit column's name in the event search results table do the following:
4.1 In the  group select the column, the name of which has to be changed ( ).Available fields 1
4.2 Click  ( ).Edit 4
4.3 As a result  dialog box with blocked  field is displayed.Configure fields Field name in the interface

4.4 Change the columns name in a required way in the event search results table and save the changes (see steps 4.3-4.4).
Click  to save the changes and close the  dialog window ( ).OK Displayed fields selection 5

Setting up the event search results is completed.

Set up the video archive

Video recordings of events are displayed in video archive. To set up the video recordings playback do the following:

Select  in the main menu of the .Settings Event search in Recognizers DBs

Note.
Click  to close this window without saving any changes ( ).Cancel 6
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1.  

2.  

As a result  dialog box is displayed. Settings

Go to  tab ( ).Configure video archive 1
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2.  

3.  

4.  

5.  

Select Overlay mode in the  dropdown list (2).Overlay

The overlay modes are presented in the table.

Overlay mode Description

No Videos from video cameras are not processed by video card

Overlay 1 Videos from video cameras are processed as one stream

Overlay 2 (set on default) Videos from video cameras are processed independently of one another

In  field set the cursor in position that determines video compression degree ( ). Minimal compression value is  – maximal video size, best quality. MaximalCompression 3 None
compression value is  – minimal video size, worst quality.Maximum
To save changes click  ( ).ОК 4

The setting of the events video recordings playback is completed.

Note.
Overlay is used to process the video using the video card and  libraries, before it is displayed. Overlay allows to improve the image due to optimization of theDirect X
pixel color settings. At the same time, the CPU's load reduces as the video is processed with the resources from the video capture card.
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1.  
2.  

1.  

Forming the search query

On the page:
Forming the search query by events
Forming the search query by alarms

 

There is a possibility to form a search query:

By events;
By alarms.

Forming the search query by events

Forming the search query by events is done in the following way:

Go to the tab .Search by events
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1.  
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1.  

2.  

3.  

4.  

From the  list ( ) select a logical construction, used for uniting several elements of the key phrase, corresponding to numbers of the vehicle, that are beingSearch operation 1
searched:
2.1  – for searching by numbers, containing all the elements of the key phrase;and
2.2  – for searching by numbers, containing at least one element of the key phrase.or

In the field  ( ) enter the key phrase, consisting of one or several comma separated elements, corresponding to the plates 'numbers that are beingVehicle's numbers 2
searched.

Picture-characters Description of Picture-characters Example   of search query

% Any string in length from zero and
more characters

Search query 'а%385%78' returns numbers, containing the elements 'а', '385' and '78', divided by any
number of characters, for example ' О ', ' mk 'А 38578 а385 78

_ (underlining) Any single character Search query '2__5' returns numbers, containing the sequence of four characters , the first of which is '2',
the last one is '5',for example, 'А 56 77', ' 11 ОК43'2 5 2 5

[] Any single character , that is contained
in the range ([а-е]) or in the set
([абвгде])

Search query '[е-м][2-5]53' returns numbers, containing the sequence of four characters. The sequence
ends in '53', the first character belongs to the range е-м, the second one belongs to the range 2-5, for
example, 'k mn02', ' bt63'453 m253

[^] Any single character , that is not
contained in the range ([^а-е]) or in
the set ([^абвгде])

Search query '[^е-м] 499' returns numbers, containing the sequence of four characters. The sequence ends
in '499', the first character does not belong to the range е-м, for example ' bk57', ' 578'b499 n499

Set the checkbox  if it is necessary to display all the numbers ( ).Plate not recognized 3

Note.
For example, search query '[a-m]3_2 and 02' may return events with numbers 'a302mm63', 'a312mm02'.

Note.
The key phrase may include usual characters and picture-characters in the required combination.
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4.  

5.  
6.  
7.  

8.  

Set the  checkbox if it is necessary to display partially recognized numbers ( ).Recognized partially 4
In the  group set the checkboxes for those regions, which events should be returned while being searched ( ).Plate region 5
In the  group ( ) set the time boundaries within which the required events have been registered. On default these boundaries are not activated (checkboxes fromDate/time 4, 5

and to are disabled). To activate the boundaries it is necessary to set the checkboxes  and/or  and then click  button ( ) and in the appeared calendar set theFrom To 6-7
required date. Enter the required time in the field  and/or . In case, if only upper or bottom boundary is selected, the search query will return the events, having been From To
registered before or after the set deadline correspondingly. To disable the search by data and time one should uncheck  and  checkboxes.From To
In the  group ( ) set the checkboxes for those plate recognizers, which events are to be returned while being searched.License plate recognizers 8

Note.
Selection on one checkbox  is active only with logical construction selection  in the  t.Plate not recognized OR Search operation dropdown lis

Note.
On default, information about objects removed from the  software package is not displayed in the  group. Select  in the Intellect Plate recognizers Show deleted View
menu of the  main window to search by removed servers of plate recognizers.Event search in the Recognizers DBs
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8.  
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8.  

9.  

a.  
b.  
c.  
d.  

10.  
a.  
b.  
c.  
d.  

11.  
12.  

a.  
b.  

13.  
14.  

15.  

a.  
b.  
c.  
d.  

1.  

From the list  ( ) select the required filter of vehicle's speed and then in the activated field (fields) ( ) enter the threshold value(values) of vehicle's speed.Registered speed 9 10
The following speed filters are available:

No matter – events of the vehicle, moving with any speed will be returned.
More – events of the vehicle, moving with a speed, exceeding a single threshold value, will be returned.
Less – events of the vehicle, moving with a speed, not exceeding a single threshold value, will be returned.
Interval – events of the vehicle, moving with a speed, belonging to a single entered threshold value, will be returned.

From the  list ( ) select the required filter concerning the direction of the vehicle. The following direction filters are available:Direction 11
No matter – events of the vehicle, moving in any direction concerning the LP recognizer's camera will be returned.
From the camera – events of the vehicle, moving from the LP recognizer's camera will be returned.
To the camera – events of the vehicle, moving to the LP recognizer's camera will be returned.
Undefine – events of the vehicle, direction of which in relation to the LP recognizer's camera has not been determined will be returned.

In the  group ( ) set the checkbox for the country, which events should be returned while being searched.Countries 12
From the list  ( ) select a logical construction, used for uniting several elements of the key phrase, corresponding to numbers of the vehicle, that are beingSearch operation 13
searched:

and – for searching by numbers, containing all the elements of the key phrase;
or – for searching by numbers, containing at least one element of the key phrase.

In the  field ( ) enter the key phrase, containing one or several comma separated elements, corresponding to the comments, that are being searched.Comment 14
Set the  checkbox in case if the event that is being searched can be left uncommented (15).Blank comment

From the  list ( ) select the required Validity filter and then in the activated field (fields) ( ) and enter the threshold Validity value (values). The following ValidityValidity 9 10
filters are available:

No matter – events of the vehicle, which numbers have been recognized with any validity.
More – events of the vehicle, which numbers have been recognized with validity, exceeding the entered threshold value.
Less – events of the vehicle, which numbers have been recognized with validity, not exceeding the entered threshold value.
Interval – events of the vehicle, which numbers have been recognized with validity, belonging to the entered threshold value.

Forming the search query by events is completed.
After forming the search query one should run its processing (see section Query launching).

Forming the search query by alarms

Forming the search query by alarms is done in the following way:

Go to the  tab.Search by alarms

  

After this all removed servers of plate recognizers will be displayed in the  group. Set checkboxes for those plate recognizers which will be usedPlate recognizers
while being searched.

Note.
 The selection of this  checkbox is active only with logical construction selection  in the dropdown list .Blank comment OR Search operation



64

1.  
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1.  
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1.  

2.  
3.  

Repeat steps 2-14 of the section  as applied to interface elements of the tab  ( ).Forming the search query by events Search by alarms 1
In the group  ( ) set the checkboxes for those external databases, which events have to be returned in search query results.External database 2

Note.
This setting is relevant in case, when the checkbox  is set in the group  (see step 9).Plate number is found in the DB Alarm type

Note.
The  group contains a list of all the databases that have ever been used together with the  module but, on default, databasesExternal database Vehicle Tracer
removed from the  software package are not displayed in the list. Select the  in the  menu of » Intellect Show deleted View Event search in the Recognizers DBs
main window to search by removed servers of plate recognizers. 
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3.  

4.  

5.  

6.  

7.  

From the  list ( ) select the required speed filter, permitted on the controlled road area and then in the activated field (fields) ( ) enter the threshold speedPermitted speed 3 4
value (values) in km/h.

The following filters of the permitted speed are available:

4.1  – events of the vehicle, registered on the road area with any permitted speed will be returned.No matter

4.2  – events of the vehicle, registered on the road area with any permitted speed, exceeding the entered threshold value will be returned.More

4.3  – events of the vehicle, registered on the road area with any permitted speed, not exceeding the entered threshold value will be returned.Less

4.4  – events of the vehicle, registered on the road area with any permitted speed, that belong to the entered threshold value range will be returned.Interval
Form the  list ( ) select the required speeding filter and then in the activated field (fields) ( ) enter the threshold value (values) of speeding in km/h.Speeding 5 6

The following filters of the speeding are available:
6.1  – events of the vehicle, moving with any overspeeding or with the absence of it will be returned.No matter
6.2  – events of the vehicle, moving with overspeeding, exceeding the entered threshold value will be returned.More
6.3  – events of the vehicle, moving with overspeeding, less than the entered threshold value will be returned.Less
6.4  – events of the vehicle, moving with overspeeding, in the entered range of threshold values.Interval
From the list  ( ) select the required filter according to the alarm handling delay and then in the activated field (fields), ( ) enter the thresholdAlarm handling delay, sec 7 8
value (values) of delay time in seconds.
The following filters of alarm handling delay are available:
6.1  – alarms, accepted in any time after being registered or unaccepted at all.No matter
6.2  – alarms will be returned, accepted with a delay, exceeding the entered threshold value.More
6.3  – alarms will be returned, accepted with a delay, not exceeding the entered threshold value. Less
6.4  – alarms will be returned, accepted with a delay, belonging to the entered threshold value.Interval

In the group  ( ) set the checkboxes for those alarms, which have to be returned in results of search query:Alarm type 9

 

As a result, all external databases removed from the system will be displayed in the list. Set checkboxes for those databases which will be used while being searched.

Note.
This setting is relevant in case, when the checkbox  is set in the group  (see step 10).Speeding Alarm type

Note.
The value of speeding is calculated as a difference between the fixed vehicle's speed and the speed, permitted on the controlled area of the road.

Note.
This setting is relevant in case if from the  list the value  or  is selected (see step 8).Alarm processed No matter Processed
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7.  

8.  

7.1  — alarms will be returned with any alarm type or with the absence of it.No matter
7.2  — alarms will be returned, triggered manually.Alarm set by operator
7.3  — events will be returned for which entering the oncoming lane has been registered.Entered the oncoming lane
7.4  — events will be returned which plates have been found in the external database.LP found in database
7.5  — events will be returned for which running a red light has been registered.Running a red light
7.6  — events will be returned for which overspeeding has been registered.Overspeeding
7.7  - events will be returned for which stopping over the crosswalk line at the stoplight has been registered.Stop over crosswalk line
7.8  — events will be returned for which stopping over the stop line at the stoplight has been registered.Stop over stop line
From the list  ( ) select the required filter according to the alarm processing factor:Alarm processed 10
8.1  —both processed and unprocessed events will be returned.No matter
8.2  — only unprocessed events will be returned.Alarm is not processed
8.3  — only processed events will be returned.Alarm processed

Forming the search query by alarms is completed.
After forming the search query one should launch its processing (see section ).Query launching

Query launching

After forming the search query by vehicles or by alarms one should launch its processing, clicking  ( ).Find 1
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As a result search results table will open ( ).2
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Viewing, printing and exporting the search results

Columns of  table ( ) are displayed in accordance to the settings, given in the  dialog window (see  section).Search results 1 Selection of displayed fields Setting up the events search

Description of the column's content is given in the same section of the Guide.

Note.
To clear the tabs ,  from the entered search criterion it is convenient to use  button ( ).Search by events Search by alarms Reset 3
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For result's navigation in the table there are used the following interface elements:
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1.  

2.  

3.  

4.  

5.  

6.  

For result's navigation in the table there are used the following interface elements:

button  – transfer to the first page of the table;

button  – transfer to the previous page of the table;

field  – transfer to the required page of the table;

field  - number of pages in the table;

button  – transfer to the next page of the table;

button  – transfer to the last page of the table.

 To print the  or/and export them to one of the most commonly used formats select the point  of the main menu in the window Event search results File Event search in the
.Recognizers DBs

As a result preview report program will launch. In the window of this program there will be displayed License plates protocol.

Note.
To transfer to the required page one should enter its number in the field 2 ( ), and then click .2 Enter
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If there are more than 1000 entries in the search results the following message will be displayed before the preview report program launch.

Click  to continue. Click  to come back to change the search criteria.Yes No

Perform the necessary operations with a report and then quit the program Preview report by following the points of the main menu  ->  or by clicking the button  (see stepFile Exit
4 in the section ).Printing and exporting the data about the vehicle

The data about violations are exported into JPG files. The file contains the camera frame, the synchronous camera frame and meta-information in the Arena module format. This
functionality is required for integration with the TRIS. The exported file can be opened in any program designed to view JPG files, but only the frame received from the main camera will
be displayed.

To export the data about violations to files select the  item in the  of the main menu in the window .Export File Event search in the Recognizers DBs

In the opened window select the folder in which photos with violations are to be exported. Click .OK
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As a result all photos with violations corresponding to event search results will be exported to the specified folder.

Previewing and printing the data about the event

To view the data about the event it is necessary to make a left click upon the corresponding string in the search results table.  dialog window will open in result.View event

Note.
If the Debug4 mode is enabled, then besides JPG-file containing frames from primary and synchronous cameras and meta-information, there will also be exported an archive
containing information for the Arena module and frames from the synchronous camera.
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1.  
a.  
b.  
c.  
d.  
e.  
f.  

2.  
3.  
4.  
5.  

6.  

In the  there are displayed the following event characteristics:View event

Video frame with a sign, containing the following data ( ):1
Date and time of receiving the data about the vehicle;
Vehicle's speed;
Vehicle's direction;
Speed, permitted on the controlled road area;
ID of speed's detector;
Control site;

Vehicle's identified plate ( );2
Vehicle's plate detector ( )2
Date and time of identifying the vehicle's plate ( );2
Vehicle's speed ( );2
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6.  
7.  
8.  
9.  

Vehicle's direction according to the LP recognition camera ( );2
Alarm's reason ( );2
Data about the vehicle for the external LP database in case if the identified number has been found there ( );3
Comments to the event ( ).4

To print the Report or/and export it to one of the most commonly used formats click the  button ( ). Preview report program will launch in result. In the window of this programPrint 5
there will be displayed Vehicle characteristics report.
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1.  
2.  

1.  
2.  

1.  

Perform the necessary operations with a report and then quit the program Preview report by following the points of the main menu  ->  or by clicking the button  (see stepFile Exit
4 in the  section).Printing and exporting the data about the vehicle

Forming the Active tracking database

The  database is the  software package database and is filled up by operator via the  module.Active tracking Auto-Intellect Vehicle Tracer

For total interaction between the  database and the  module the following conditions should be met:Active tracking Vehicle Tracing

The  database is connected to the  spftware package as an external plates database.Active tracking Auto-Intellect
This external database is used by  module for analyzing the identified plates.Vehicle Tracer

Meeting the following conditions the interaction of the  database and  module is done in the following way:Active tracking Vehicle Tracer

Vehicle's plate is entered by operator to the  database via the  module, stating the reason.Active tracking Vehicle Tracer
The  module compares the plate of a passing vehicle with plates, stored at the  database. In case, if the correspondence of the identified plateVehicle Tracer Active tracking
and the plate, stored at the  database is set up, alarm is generated.Active tracking

Active tracking option is convenient to be used in the  distributed system, as it enables the operator at his workstation to notify the remote workstation operators aboutAuto-Intellect
the vehicle that is to be captured.

Editing the data about the vehicle in the  database is done in the following way:Active tracking

Click the  in the main menu of the  window.External Plates Database Event search in the Recognizers DBs

Note.
It is impossible to remove and change records excepting the status of stolen vehicle reports changing via the  module.Vehicle Tracer
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1.  

2.  

3.  
4.  

As a result  dialog window will open.Internal SVDBs

Click  to add records to the database.Enter
Enter the vehicle plate in the  field ( ).License plate number: 1
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4.  

5.  
a.  
b.  

6.  
7.  

8.  

If the fact of vehicle driving to the stolen vehicle report by all boundaries is to be checked, do the following:
Set the  checkbox ( ).Check the fact of driving 2
Enter the time period using the  buttons and select the measuring unit from the drop-down list ( ).up-down 3

Enter the description of reason by which the stolen vehicle report is created in the  field ( ).Additional information 4
Click  to save changes ( ).Save 5

Go to the  tab to change the status of stolen vehicle report.All Stolen Vehicle reports

Note.
Click  to cancel changes ( ).Cancel 6

Note.
Entered stolen vehicle reports are added to the database with the  status.Active
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8.  

9.  

10.  

11.  

12.  
13.  

1.  

 The list of stolen vehicle reports in database is displayed in the table ( ):1
9.1 Plates of vehicles are wanted are specified in the  column.License plate
9.2 Time of adding the stolen vehicle report to the database is specified in the  column.Date and Time
9.3 Operator who has added the stolen vehicle report to the database is specified in the  column.Operator
9.4 The reason by which the stolen vehicle report is created is specified in the » column.Comment
9.5 Checkboxes are set on the active stolen vehicle reports while viewing in the  column.Active
Enter the part of the sought-for vehicle in the  field and click  to search vehicle in the table ( ). Records corresponding to the request parameters will beLicense plate: Search 2
highlighted red in the table.
Set checkboxes opposite those stolen vehicle reports which are active and uncheck checkboxes opposite those reports which are inactive in the  column to change theActive
reports status ( ).4
Click  to refresh the list of stolen vehicle reports ( ).Refresh 5
Click  to save changes ( ).Save 6

Adding the vehicle data to the  is completed.External Plates Database

Viewing the videо archive by event

Viewing video archive by event is started in three ways:

Call for a required event contextual menu by clicking right mouse button and select  option.Video archive
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1.  

2.  
3.  

Select the required event by single clicking left mouse button and click  key combination.Ctrl + M
Holding  key click the required event twice with left mouse button.Shift

Video archive with videos of this event opens after carrying out any of above mentioned operations.

To close the video archive it is necessary to click the  sign in the right upper corner of the window.

Viewing the video archive by event is completed.
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Description of the Auto-Intellect user interface
The Traffic Monitor interface object

Table panel of the Current value tab
The following figures show the  sub-tab of the  tab displayed by lane and by direction respectively (depending on the system setup).Table Current value

Dispalying by lanes:

Displaying by direction:
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The following table describes the elements of the  panel.Table

Field name Description

Time of registration The time when the last vehicle passed
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Total number of vehicles Total number of registered vehicles of all types

Motorcycles The number of registered motorcycles

Passenger cars The number of registered passenger cars

Trucks less than 12 m long The number of registered trucks less than 12 m long

Trucks more than 12 m long The number of registered trucks more than 12 m long

Buses The number of registered buses

Registered speed of the vehicle The speed of the last registered vehicle, km/h

Vehicle length Total length of the registered vehicle, m

Average speed for all vehicles Average speed for all registered vehicles, km/h

Average speed for passenger cars Average speed for passenger car vehicles, km/h

Average speed for trucks Average speed for registered trucks, km/h

Distance between vehicles The distance between the last vehicle and the previous one, m

Road load Average road load, %

Number of speed overruns The number of speeding violations

Moving along the oncoming lane The number of moving along the oncoming lane events

Number of vehicle stops The number of vehicles stopped in the lane

Jam Traffic jam indicator

Number of incidents Total number of road rules violations for the lane (direction)

Charts panel of the Current value tab
The following figured show the  panel of the  tab displayed by lane and by direction, respectively (depending on the system setup).Charts Current value

Displaying by lanes:
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Displaying by direction:
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The following table describes the elements of the  panel.Charts

Number

of element

Description

1 The Traffic Detector name

2 The lane number or direction

3 Total number of vehicles registered for the lane (direction)

4 Indication of a traffic jam in the lane (direction)

5 Chart showing the number of vehicles in the lane (direction)

6 Chart showing the road load of the lane (direction), %

7 Chart showing the statistics for the average speed of different vehicles types
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Table panel of the Statistics tab
The following figure shows the  sub-tab of the  tab.Table Statistics

The following table describes the elements of the  sub-tab.Table

Number

of element

Description

2 Set of elements for selecting the statistic frequency

3 Set of elements for entering the beginning and end dates and times of the traffic statistics period

4 The  button refreshes the displayed statistics.Refresh

5 The  button exports the displayed statistics to a fileSave as
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6 Traffic statistics results

Charts panel of the Statistics tab
The following figure shows the  panel of the  tab.Charts Statistics
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The following table describes the elements of the  panel.Charts

Number

of elements

Description

1 Set of elements for entering the beginning and end dates and times of the traffic statistics period

2 The  button refreshes the displayed statistics.Refresh

3 The  button exports the displayed statistics to a fileSave as

4 Set of elements for selecting the statistic frequency

5 The Traffic Detector name

6 The lane number

7 Incident statistics for the lane

8 The road load chart

9 Chart showing the number of vehicles in the lane

The Vehicle Tracer interface description

The Events monitor
The  contains the following interface elements.Events monitor
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The Events monitor interface description is presented in the table:

Number

of elements

Description

1 Detector of passing vehicle's plate

2 Signed frame with a passing vehicle

3 Identified vehicle's plate and speed (when the Uragan or CARMEN-Auto modules are used, the Radar module should be connected)

The Alarm window
The  contains the following interface elements.Alarm window
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The Alarm window interface description is presented in the following table.

Number

of
element

Description

1 The signed video frame with moving vehicle

2 Date and time of alarm event fixing.

3 Displaying the vehicle LP

4 Data about vehicles with which help the alarm was fixed

5 Orientation description

6 Go to the first orientation in the list; go to the previous orientation; go to the next orientation; go to the last orientation in the list
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7 If the checkbox is set it disappears from all alarm windows in distributed environment when the alarm is confirmed, when the alarm is not confirmed – only from the
current alarm window. 
If the checkbox is not set the alarm disappeared only from the current alarm window both when the alarm confirmed or not.

8 Confirm the event alarm status. The alarm is marked as received when click this button. The dialog box with the offer to print the orientation card will display.

9 Close the orientation window. The alarm status is not changed when click this button (alarm is not processed). Alarm will disappear from the .Alarm window

The On-line monitor
The  contains the following interface elements.On-line monitor

The  interface description is presented in the following table.On-line monitor

Number

of  elemtnt

Description

1 Data about the last passed vehicle or event, selected in the identified vehicles protocol or in the alarms protocol

2 Transfer to the Events tab of the identified vehicles protocol.
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3 Transfer to the alarms protocol tab. 
With alarms there displayed a video frame and number of the last alarm on the tab.

4 Hidden in the processes events protocols

5 Enabling/disabling setup filters.

6 Resuming the operative update of the displayed vehicle's protocol.

7 Triggering the alarm by operator.

8 Alarm acceptance.

9 Transfer to the list of errors in the operation of Vehicle Tracer module

10 Displaying the commentary to the selected event.

11 The identified objects protocol or alarms protocol dependent on activated tabs- 2 or 3.

12 Roll down/roll up the displaying panel of comments and base.

13 Displaying the information from the external database.

14 Forming the report with data about the selected event.

15 Opening the search window in the plates recognizers databases.

16 Transfer to the video archive of identified vehicles.

17 Transfer to filter settings, used in protocols.

18 Comments to the selected event with stated data and time of the commentary.

The Events search in recognizers databases
The  dialog window contains the following interface elements.Events search in recognizers databases
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The  interface description is presented in the following table.Events search in recognizers databases

Number

of element

Description
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1.  
a.  
b.  

2.  
a.  

3.  
a.  
b.  

4.  
a.  

5.  
a.  

1 The main menu, that enable to do the following operations:

File command: 
Printing the events search results;
Closing the window Events search in recognizers databases

View command: 
Setting up the displaying of remote servers and databases;

Settings command: 
Setting up the displaying of events search results;
Connecting the recognizers databases.

Servers command: 
Selecting the databases for searching the events.

Command Active tracking database 
Editing the Active tracking user database

2 Selecting the type of search: by events or by alarms

3 Forming the search query of the selected type

4 Clearing the search form from the given search criteria

5 Launching the search query processing

6 Events search results table

7 Navigation panel of the events search results

The preview report
The preview report program window contains the following interface elements.
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The preview report interface description is presented in the following table.

Number 
of
element

Description

1 Main program's menu for viewing the reports (operations with a file, operations of previewing and navigating the report, operation with a report, viewing the
information about program)

2 Block of elements for operations with a report file (printing, opening, saving, exporting the file)

3 Block of elements for operations with a report (displaying, content, search, update, edit)

4 Selecting the scaling mode and the scale of displaying the report

5 Zooming the report

6 Selecting the mode of displaying the report (displaying the pages by one page, nonstop page-by-page displaying)

7 Block of elements for navigation of the report

8 Block for step back and step forward of actions

9 Field for displaying the formed report
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